## Contents

Overview of Oniqua Analytical Solution (OAS) ................................................................. 3

1.1 Inventory Management Methodology ........................................................................ 7

1.2 Data Segmentation ..................................................................................................... 11

1.3 Analysis Tools ........................................................................................................... 14

1.4 User Analysis Tools .................................................................................................. 21

1.5 Utilizing the Inventory Profile Codes ........................................................................ 23

2.1 Terminology ............................................................................................................... 26

2.2 Forecasting ................................................................................................................. 28

2.3 Reorder Point ............................................................................................................ 30

2.4 Reorder Quantity ....................................................................................................... 33

2.5 ROP and ROQ Methods. .......................................................................................... 35

2.6 Service Level ............................................................................................................ 36

3.1 Understanding the OAS Process ............................................................................... 37

3.2 Introduction to Oniqua Analytics Solution (OAS) ..................................................... 40

3.3 Working with Groups ............................................................................................... 41

4.1 Workbench Layout .................................................................................................... 58

4.2 Navigation in the Group View Window ..................................................................... 60

4.3 Data Visibility ............................................................................................................ 62

4.4 Main Header Display – Key stock item parameters .................................................. 64

4.5 Workbench tabs ........................................................................................................ 67

4.6 Filter, Sort and Manage Data from Workbench ....................................................... 77

4.7 Reviewing results ..................................................................................................... 93

4.8 Exporting to the ERP ............................................................................................... 100

5.1 Workflow Review Overview ..................................................................................... 103

5.2 Work Queues ............................................................................................................ 105

5.3 By Control Segment ............................................................................................... 107

5.4 Data Exception Management ................................................................................... 110

6.1 Reporting with OAS ............................................................................................... 124

6.2 Importing data in OAS ............................................................................................ 129

6.3 Loading projected/planned demand usage into OAS .............................................. 134
Overview of Oniqua Analytical Solution (OAS)

Provides scientific answers to three important questions:

- How much do we need?
- How much should we order?
- When should we order?

Provides structured methodology for:

- Monitoring usage
- Managing stock levels
- Maximizing service levels

Inventory Visibility

Providing organizations with clear visibility of their inventory assets, coupled with the built-in analytics capability and flexible functionality, allows organizations to combine data from one or more transactional systems providing global visibility across the entire Enterprise.

Inventory **Visibility** allows:

- Conversion and migration of legacy data from multiple ERP systems providing total historical visibility
- Combining data across the entire enterprise
- Linking catalogue records to historical transaction activities
- Analysis of trends and inventory performance
- Visibility of surplus and inactive stock holdings
- Managing multiple records with similar profiles using one process

Performance Measurement

Inventory analysts can slice and dice inventory data to determine stock holdings of key commodities across the organization. Executives can measure and compare inventory performance across all sites using consistent key performance indicators.
Segmentation

Managing tens or hundreds of thousands of inventory items requires a methodology that allows inventory policies to be consistently applied.

Oniqua inventory analytics automatically analyzes each stock item using characteristics such as price, usage, movement, lead time and criticality. Using these profiles, items are automatically placed into control segments from which new recommended reorder levels are calculated and loaded back into the transactional system.

Flexible exception rules alert inventory managers to items that need individual review.

Inventory **Segmentation** allows:

- Building of profiles
- Criticality Analysis
- Application of different policies
- Management by exception

Optimization

Based on published research by the US Air force and UK Coal Board and refined over fifteen years of practical experience working with asset-intensive companies, Oniqua’s inventory optimization algorithms are uniquely suited to the complexities of MRO inventories.

Inventory **Optimization** allows:

- Use of algorithms uniquely suited for the complexities of MRO inventories.
Oniqua Inventory Analytics allows organizations to use their own economic cost model recognizing: holding, replenishment and stockout costs, to optimize their inventory. In this way, users can model and understand the financial impact of all decisions before they are implemented.

Inventory **Modeling** allows:

- Use of an organization’s economic costs
- Understanding of the financial impact of all decisions before they are implemented

<table>
<thead>
<tr>
<th>Functionality</th>
<th>Benefit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost modelling</td>
<td>Balance holding, replenishment and stockout costs</td>
</tr>
<tr>
<td>What-if analysis</td>
<td>Analyze new business scenarios</td>
</tr>
<tr>
<td>Service level analysis</td>
<td>Identify and remedy over and under stocking</td>
</tr>
</tbody>
</table>
Why do People Use Oniqua Analytics Solution?

Oniqua Analytics Solution helps to:

- Reduce unnecessary spend and provides ways to save money
- Minimize stock outs and helps users to focus on important issues
- Provide a high and quick Return on Investment (ROI)

Pre-Configured business rules help to:

- Get the system up and running very quickly

Proven track record helps to provide a level of confidence that Oniqua knows how to get results

OAS Closed-Loop Optimization Process

The below diagram shows the ‘Closed Loop’ Optimization which OAS performs in the Inventory module.

The important things to note are:

- We use data from the ERP system and carry out extensive analysis
- We update the ERP system...but ONLY what the user wants to update and ONLY the ROP/ROQ or MIN/MAX. Some other OAS fields can be included in the upload process to improve the information in the ERP system however it is general information only.
1.1 Inventory Management Methodology

Inventory Management Methodology

Inventory is stock held by an organization to support its business activities. To some organizations inventory management consisted of throwing more and more money at inventory in the hope that a philosophy ‘of nothing succeeds like excess’ would rescue the organization from the inconvenience and expense of a stock out.

Inventory management involves the control and optimization of stock levels. Many organizations have only come to realize the value of inventory management in recent years.

At many sites the inventory is one of their largest assets. At most sites it constitutes an asset worth many millions of dollars. The reduction of inventory by as little as a few percent, will at most sites result in the investment in inventory being reduced by millions of dollars. This represents funds which the organization can either invest in more profitable areas or reduce a debt on which interest is being paid.

When millions of dollars are at stake - of course inventory management is important.

Stock Management Policies

Inventory management theory is simply quantified common sense. Most of us use these principles in our private lives intuitively. Essentially, the philosophy is to have a stocking policy for each item according to its characteristics and usage pattern. There are lessons that we can learn from home use items that we can apply to our corporate supply management.

The following are examples of this:

- **Tea Bags**: We buy these in boxes of 200 or so because they are cheap. The resources required to buy smaller quantities (and more frequent visits to the supermarket) are not matched by the savings that could be made by holding an ‘inventory’ of fewer tea bags.

- **Carpets**: Nobody keeps a spare carpet. The reason is that carpets are not essential to living. They are not subject to catastrophic failure and even if one gets ripped it can be replaced at leisure. Moreover, they are expensive to buy and bulky to store.

- **Light Bulbs**: Whether we keep spare light bulbs depends on the inconvenience the loss of the lamp could cause. They are readily available and thus a replacement can be obtained in a short time.

- **Fuses**: People used to keep spare fuses (or wire) because they were cheap but can cause a major inconvenience if one was to blow. They have very low usage (if not call an electrician right away) but are ‘stocked’ in case of an emergency. Nowadays, these are an obsolete item.

- **Paper Towels**: These are cheap items but we keep our stock low and purchase regularly because they are bulky to store.
• **Bananas**: These are cheap items but we keep our stock low and purchase regularly because they have a limited shelf life.

• **Car Tires**: The inconvenience of being stuck with a flat tire is worth giving up a bit of boot space and the expense of buying a fifth tire. Contrast this with the windscreen, which will not cause as much inconvenience (the car can still go) and will be much more inconvenient to store.

Stock Management Policies usually answer three major questions:

• What is being used? Forecast Usage

  Historical analysis to predict the future requirements – using a guess or science?
  • When to order? Reorder Point (ROP or Min)

  Determining at what ‘point’ of stock level should trigger a stock order to replenish – allowing for continued usage during supply delivery time, safety stock according to criticality and the quantity that could ‘overshoot’ the ROP.

  • How much to order? Reorder Quantity (ROQ or Max)

  Up to what stock level to replenish to – allowing for warehouse capacity, costs associated to holding inventory and re-ordering cycles.

Other considerations for stocking policies are:

• How do you arrive at the right values?

• Did you consider the various costs?

• Did you consider any service level requirements?

• Did you consider any turnover requirements?

The Costs of Inventory

Not only does the inventory consume valuable capital, there are ongoing costs to consider as well. These are as follows:

**Holding Costs**
The largest of these costs is the interest that must be paid or conversely the lost opportunity cost forgone in having the capital tied up in non-productive (inventory) use. Additionally, there is storage, stocktaking, and insurance costs as well.

**Replenishment Costs**

These are the costs of procurement of items either into stock, or for immediate use. The aggregate costs of the resources required to place orders, receipt goods, replenishment of bins and payment of invoices make up the replenishment cost.

**Stock Out & Expediting Cost**

These costs are based on the loss and/or inconvenience suffered by an organization as a result of an item being out of stock when needed. Additionally, the costs incurred by the supply department in expediting these items in emergency situations are considered as well.

These three costs should be balanced for every item in the inventory. It can be proven that where imbalances occur the aggregate supply cost will increase.

Each ROP/ROQ (Min/Max) commits the company to some level of spending in holding, purchasing and stock out costs. It is thus important to get these values correct.

**Why do We Hold an Item in Stock?**

There are many reasons why items may be held in stock, examples are as follows:

**An Item has high usage**

- Even if it costs more to hold an item in stock than to buy it in as you need it, it is frequently more economical to have the items readily available on site rather than have staff ordering and obtaining items as they need them. (e.g.: stationery, safety gloves etc.)

**An item has a high Business Impact (if not in stock when needed)**

- Many items are held in stock for use when an important item on site fails. The failures may (or may not) be rare but in any event the need to sustain production will make the urgency to source a replacement very acute. (e.g.: transformers, bearings etc.)

**An item has a long lead time**

- Some items take a long time to be supplied after they are ordered. These items may be supplied from overseas or need to be specially manufactured. When this delay would cause unacceptable inconvenience or loss, the item should be stocked. (e.g.: H.V. Circuit Breakers, electronic circuit boards etc.)
Replenishment costs are minimized by volume purchasing

- The cost of supplying an item can frequently be greatly reduced through purchasing an economic quantity of items each time. This will apply to items where the usage is fairly high and the unit price is low. (e.g.: tea bags, nuts and bolts etc.)

There are other reasons why stock may be held.

- To cope with natural disasters and emergencies.
- For insurance or legal regulations.
- Older parts may not be available anymore.

When is an Item not suited to be held in stock?

There are items which do not meet any of the above criteria. Such items should not be stocked. Vendor held stocking or cataloguing but not stocking should be considered in these cases.

Some reasons may be:

- It is no longer used (Usage)
- It is not important to production (Business Impact)
- It is easy to obtain (Lead Time)
- Purchasing cost is low (Economics)
- Price too high (Economics)

Why do We Have a Warehouse?

The argument which advocates a massive reduction in warehouse stock in favor of an excessive dependence on such practices as vendor held stock, direct purchase and vendor maintained stock is sometimes too seductive for some companies to resist. Whilst such decisions can give the illusion of reduced inventory, the implementation of such an approach for inappropriate items can sometimes result in the following outcomes:

- Items purchased on direct purchase can lie around in workshops and elsewhere on site and are lost. Over time a burgeoning non stock inventory is built up and gets out of control.
- Items are over ordered due to poor communication and flawed logic. One frequently encounters instances where items are ordered twice especially at change of shift.
- A heavy penalty is paid in resourcing the replenishment process.
- Vendors will stock at levels to suit their needs not yours.
- Items with high business impact cannot be obtained (or found) when needed.
- Usage of items cannot be monitored.
- Appropriate control and care of items is not maintained

This is not to say that all items are best managed in the warehouse. OAS will create a control group called 'Potential Non Stock' in which items suited to a NON STOCKED management strategy are identified. The danger lies in carrying the NON STOCKED philosophy too far.
1.2 Data Segmentation
Creating control segments

Control Segments are an important part of OAS and are used for targeting items to review making good use of one’s time. The segmentation is applied by an OAS Autotask during the Periodic Update. More information about creating rules is available for Administrators.

Control Segments characteristics:

- The main OAS methodology for inventory management
- They contain items with the same Inventory characteristics
- They have specific management policies for each segment

The Control Segments are user definable and are based on various rules achieved by:

- Using ERP classifications codes
  - e.g. If the CLASS= ‘O’ then OAS will put the item into the ‘Obsolete’ Control Segment
- Using pre-configured OAS business rules
  - The Control Segment names and rules are decided at implementation, but can be adjusted at any time
- Using customized business rules

Typically, items are reclassified after every month end PU update process and the segmentation definitions hierarchical rule order is:

- Set items based on the ERP settings, e.g. Obsolete or Repairable etc.
- Set remaining items based on OAS pre-defined and user-defined rules e.g. New Items are records with less than 6 months of usage, Potentially Obsolete items have no usage in a 3-year period
- Set the remaining items based on usage, moving and/or availability codes, i.e. Slow moving items, and finally Fast moving items with normal or general classification codes

A typical control segmentation is shown below:
Viewing Segmentation Definitions

Control segments are defined to match the business objectives and associated management policy designed for capturing similar profile items for a specific review process. All users have access to view these rules under the ‘Properties’ option for the Control Segment field.

To view the rules:

- Create a group (can be any group, even a single record)
- Right click on the Control Segment field in the header section
- Select Properties and then Task details
The rules are applied from the top down to each item record at each month end Periodic Update. The hierarchal order or positioning of a control segment will determine whether (in time) an item may fall out of one control segment into another or not as is the case for OBSOLETE (unless reclassified in the ERP system).

A typical control segmentation can be seen below:
1.3 Analysis Tools

There are five major analysis tools that are fundamentally used by OAS in the management of items. These provide key criteria in classifying items into appropriate management groups as well as in enabling other important management decisions in the stock optimization process. When combining these codes, especially applying the converse concept of ‘not equal to’ opens up an unlimited variety of options that can be used.

Understanding the methodology behind each of these codes is the most significant aspect of OAS that needs to be covered before using the OAS solution.

The ABCD Usage Analysis

In this process, the objective is to segment the inventory according to how much a record is used in terms of its historical consumption:

- Firstly, the ‘usage value’ of each item is calculated using the following methodology:
  - Determine the total quantity of each record where unscheduled usage has occurred in the past 24 months
  - Multiply the two-year usage quantity for each item by its moving average price
  - Divide the two-year usage value by two to represent the ‘Average Annual Usage Value’

- Secondly, OAS will then rank items in descending order by their ‘Average Annual Usage Value’
  - Thirdly, Usage Codes ‘A’ to ‘C’ are then assigned to items with an ‘Annual Usage Value > $0’ according to defined % allocation
  - Finally, Usage Code D is applied to those records with no Annual Usage Value (remember this is actually determined over a two-year period)
It should be noted that an item with very low (or zero) price will always have a Usage ABCD Code = ‘D’ regardless of how frequently it is issued.

A typical view of a data set by Annual Usage Value using the ‘Distinct Values’ option on the Usage ABCD Code field (Codes Tab):

- Note the relativity of the number of records in each segment to the current stock value and surplus stock value
- With OAS providing visibility of this Usage Code analysis, management strategies can be established around this code for high usage value records especially:
  - Usage ABCD Code = ‘A’ or ‘B’
The XYZ Holding Analysis

In this process, the objective is to segment the inventory according to each record’s Current Stock Value which is normally based on the ERP system’s Moving Average Price for each record:

- Firstly, the ‘Current Stock Value’ of each item is calculated:
  - This is done by multiplying the Stock On Hand for each item by its Moving Average Price as provided by the ERP system

- Secondly, OAS will then rank the items in descending order by ‘Current Stock Value’

- Thirdly, XYZ holding Codes are then assigned to items according to an item’s position in the ranking and the defined % allocation
  - Note that distortion can occur where large numbers of cataloged but not stocked records are included in the OAS data sets
  - Normally the % assigned to each of the three codes are as shown here however they can be amended to suit client preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Stock Units</th>
<th>Unit Price $</th>
<th>Stock Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>001</td>
<td>100</td>
<td>$5.00</td>
<td>$500</td>
</tr>
<tr>
<td>002</td>
<td>500</td>
<td>$0.10</td>
<td>$100</td>
</tr>
<tr>
<td>003</td>
<td>1</td>
<td>$100</td>
<td>$0</td>
</tr>
<tr>
<td>004</td>
<td>0</td>
<td>$50</td>
<td>$1500</td>
</tr>
<tr>
<td>005</td>
<td>5</td>
<td>$1.00</td>
<td>$5</td>
</tr>
<tr>
<td>006</td>
<td>25</td>
<td>$10</td>
<td>$2000</td>
</tr>
<tr>
<td>007</td>
<td>50</td>
<td>$15</td>
<td>$1500</td>
</tr>
<tr>
<td>008</td>
<td>2</td>
<td>$1000</td>
<td>$0</td>
</tr>
<tr>
<td>009</td>
<td>10</td>
<td>$20</td>
<td>$200</td>
</tr>
<tr>
<td>010</td>
<td>10</td>
<td>$5.00</td>
<td>$100</td>
</tr>
</tbody>
</table>
• A typical view of a data set by Current Stock Value using the ‘Distinct Values’ option on the XYZ Holding Code field (Codes Tab):
  
  o Note the relativity of the number of records in each to the value
  
  o With OAS providing visibility of this Holding Code analysis, management strategies can be established around this code, such as:
    ▪ Stock taking strategies
    ▪ Focus on high value records
    ▪ Automation policies for low value records

Moving Code Analysis

The Moving Code Analysis is an indicator of the issue activity (frequency) of an item. This is based on the concept of a ‘moving month’ where the moving month is a month where an unscheduled issue has occurred. It makes no difference if one item was issued or one thousand and one; there need only be one item issued in the month to count as a movement.

Items are assigned a moving code according to the number of months of actual movement over a 24-month period.
This table shows an example of the use of Moving Code analysis for a range of Stock Code usage history. Where an item has been in stock for fewer than 24 months, based on the record’s Date of Creation in the ERP system, the moving code is calculated on a pro-rata basis.

<table>
<thead>
<tr>
<th>Periods with recorded usage</th>
<th>Periods with zero usage</th>
<th>Moving code</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 in 24</td>
<td>0 in 24</td>
<td>6 Fast</td>
</tr>
<tr>
<td>18 to 23</td>
<td>1 to 6</td>
<td>5 Moderate</td>
</tr>
<tr>
<td>12 to 17</td>
<td>7 to 12</td>
<td>4 Slow</td>
</tr>
<tr>
<td>6 to 11</td>
<td>13 to 18</td>
<td></td>
</tr>
<tr>
<td>3 to 5</td>
<td>19 to 21</td>
<td></td>
</tr>
<tr>
<td>1 to 2</td>
<td>22 to 24</td>
<td>1</td>
</tr>
<tr>
<td>0 in 24</td>
<td>24 in 24</td>
<td>0</td>
</tr>
</tbody>
</table>

The monthly usage record over last two years

- A typical view of a data set by Moving Code using the ‘Distinct Values’ option on the Moving Code field (Codes Tab):
- Note specifically the following:
  - The relativity of the number of records in each code compared to the reported current stock and surplus values
    - The diminishing count of records to the code
    - The high number of records with Code = 0 and stock value (represents no movement in 2 years)
    - The segmentation of the FAST, MOD and SLOW records
- With OAS providing visibility of this Moving Code analysis, management strategies can be established around this code, such as:
  - Optimizing reorder level settings for FAST and MOD moving records acceptable to upload to ERP systems
Identify records with high moving codes and combined with other analysis codes to:

- Set reorder levels in the ERP system where currently set at 0/0
- Set appropriate manual reorder levels for important records where optimal settings are inappropriate

Identifying low moving code records and combined with other analysis codes to:

- Focus on high value items with surplus SOH for possible reductions
- Identify records no longer being used for possible removal from stock or making non-stocked

Availability Analysis

The objective here is to analyze the time taken for an item to be replenished after an order has been placed; this is called the Lead Time. There are three components that make up Lead Time, these are:

- **The ‘Review’ Lead Time** (alias the Administrative Lead Time) is the time taken between the Reorder Point being broken and the order being placed plus the time taken for goods to be receipted and being replenished in the bins ready for issue

- **The Supplier Lead Time** is the time taken for an order to be placed and for the goods to be delivered to the receipting point

- **Delivery lead time** is the measure of offsite receipts from the supplier to a freight delivery service, to when the goods are delivered to the warehouse on site. Where supplier delivery is direct to a warehouse then the delivery lead time will be zero days.

Whilst the exact average lead time is used by OAS to optimize stock levels, an availability analysis is carried out to segment stock items into three broad categories based upon the total lead time analysis.
A typical view of a data set by Lead Time using the ‘Distinct Values’ option on the Availability Code field (Codes Tab):

- Note the relativity of the number of records in each to the reporting current stock and surplus values
- It stands to reason that you might expect a low number of records to be with a long lead time however you would also expect that these will contain a high stock value and even surplus value to the current requirements because of their long lead times
- With OAS providing this code analysis and visibility management strategies can be established based on this code

The ABC code is used for all clients however the number of weeks allocated to the codes will vary from client to client depending on local supply conditions. Where there is a large number of non-stocked records in OAS that do not require ROP/ROQ (Min/Max), control segmentation may be based only on the remaining stocked records to determine the best allocation.

<table>
<thead>
<tr>
<th>Code</th>
<th>Total lead time</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>&gt; 4 Weeks</td>
<td>Long lead time</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Overseas suppliers</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Manufactured item</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Very small chance of expediting</td>
</tr>
<tr>
<td>B</td>
<td>&gt; 2 Weeks</td>
<td>Moderate lead time</td>
</tr>
<tr>
<td></td>
<td>&lt;= 4 Weeks</td>
<td>May be able to expedite</td>
</tr>
<tr>
<td>C</td>
<td>&lt;= 2 Weeks</td>
<td>Short lead time</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Local Supplier</td>
</tr>
<tr>
<td></td>
<td></td>
<td>F.P.A. Item</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Available off shelf</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Can usually be expedited</td>
</tr>
</tbody>
</table>

- With OAS providing visibility of this Availability Code analysis, management strategies can be established around this code, such as:
  - Optimizing reorder level settings for long lead time records to ensure safety stock levels cater for the lead time usage during the reorder cycle
  - Considering whether to stock an item or not if it is readily available (short lead time records)
  - Comparing actual lead time analysis to the stated lead times in the ERP system
  - Identifying those records in the ERP system with long lead times that are continuously encountering stock outs
1.4 User Analysis Tools

Business Impact Analysis

In order to identify the cost of stocking out of an item, OAS needs to know the importance of the item in maintaining production on site.

- The business impact is ranked in a scale typically like the one here

<table>
<thead>
<tr>
<th>Code</th>
<th>Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Severe impact</td>
</tr>
<tr>
<td></td>
<td>Definite production loss</td>
</tr>
<tr>
<td></td>
<td>Shutdown likely</td>
</tr>
<tr>
<td>B</td>
<td>Possible minor production loss</td>
</tr>
<tr>
<td></td>
<td>Severe risk of total production loss</td>
</tr>
<tr>
<td>C</td>
<td>Major maintenance disruption</td>
</tr>
<tr>
<td>D</td>
<td>Minor maintenance disruption</td>
</tr>
<tr>
<td>E</td>
<td>Items held for convenience only</td>
</tr>
</tbody>
</table>

- Costs are assigned to these scales from which, along with other factors, the stock out cost can be assessed

- Where a client has their own established business impact coding OAS may be setup to work either fully or partially from this. Moreover, the above definitions may be varied to suit client circumstances.

- The Business Impact Code definitions are chosen to make them as easy as possible for staff to relate to, as well as to obtain a satisfactory breakdown of stock items across the inventory

Likelihood of Stockout

The stockout costs assigned from the Availability/Business Impact analysis discussed above assume that the full impact of a stockout will be incurred if an item is unable to be supplied from stock. Whilst having an item available in stock is the only acceptable option for some items, for the great majority of items there are other (albeit less desirable) options available that can reduce the likelihood of the full stockout cost being incurred. To argue that the world will end if an item is not sitting on a shelf in the warehouse when needed does not give credit to the resourcefulness of maintenance and supply staff!

The concept behind assessing likelihood codes is to devalue the stockout risk assigned to an item based on options and/or actions available to resolve the need for an item other than always having the item in stock. It should be noted that this is not a strategy to avoid stocking items, but it will acknowledge that there can be times (such as during the lead time after an item has been issued) where a spare may not be available ‘off the shelf’.
There are five types of ‘Likelihood of Stockout’ codes available which are in common use. These are defined as follows:

**Almost Certain**

The stockout costs associated with the Business Impact will be incurred by the organisation due to unavailability of stock. The item must be available or the stockout risk will be very expensive, as alternative actions do not exist to avert the loss.

**Likely**

It is more than likely that the stockout costs associated with the Business Impact will be incurred in the event of a stockout. While actions might be possible to alleviate the consequences of a stockout, these actions are limited and may or may not be taken.

**Possible**

It is possible the stockout costs associated with the Business Impact will be incurred by the organisation in the event of a stockout. There are known workarounds that may be possible, and these actions might be taken to alleviate the consequences of a stockout.

**Unlikely**

It is unlikely that the stockout costs associated with the Business Impact will be incurred in the event of a stockout. There are known workaround actions that are possible, and these actions will be taken to alleviate the consequences of a stockout. This may be the additional cost incurred in expediting the supply of an item, or an inconvenience to maintenance crews in having to reschedule planned works.

**Rare**

It is rare or highly unlikely that the full impact to the business will be incurred in the event of a stockout. This implies that actions can and will be taken to alleviate the consequences of a stockout, such as increased monitoring of the associated equipment until the replacement item is received in to stock.
1.5 Utilizing the Inventory Profile Codes

The various codes are combined in matrices using the characteristics we have been looking at.

Combining the profile codes provides:

- Ways to further segment the data
- Ability to target items in a consistent way
- A methodology to apply costs to items based on their segmentation

Combining the different profiles provides a model for adding values to the different scenarios.

The combination of business impact code and the availability code of an item collectively forms a powerful tool in determining stock out cost.

The worst case would be for an item where the business impact was ‘A’ and the Availability Code was also ‘A’. By definition, such an item would be a major production stopper which would necessitate a long lead time to bring into stock.

At the other end of the scale are items with a business impact of ‘E’ and an availability of ‘C’. These items have negligible impact on the business and are readily available. Such items would be held for convenience reasons only and should not be stocked at all if their usage is low. The ‘Danger’ in the diagram is changed into a risk avoidance cost.

The actual stock out cost experienced for each Business Impact/Availability combination varies widely from client to client. In addition to the stock out cost experienced by the user, there is also the cost incurred by the supply department in expediting goods onto site under emergency conditions. The level of expenditure committed to expediting will diminish the stock out inconvenience suffered by users.
Costs are associated with combinations of the profile codes providing a means to process inventory in a consistent manner.

- **Holding Costs**
  - Uses Moving Code and Usage ABC and additional parameters

- **Stock Out Costs**
  - Uses Business Impact, Availability, Moving Code and Likelihood options

- **Expediting Costs**
  - Uses Business Impact, Availability, Moving Code and Likelihood options

The values shown on the following example matrix are representative of the stock out and expediting costs one could incur in the various combinations of Availability and Business Impact Codes.
Default values (sometimes quite dissimilar to the ones shown) are setup in a client system according to the local requirements. Thus, whenever an inventory item is optimized by OAS the value from the table can be used to assign a stock out cost or risk to that item.

The stock out cost assigned to an item will vary according to the options selected for that item, i.e. the item’s Likelihood option, the Availability and the Business Impact. The default values for each combination of Likelihood, Availability and Business impact are assigned in the cost model tables.

This allocation of stock out cost to an item plays an important role in determining the amount of safety stock OAS will recommend for an item. Much more will be said about this later in these notes when we look at the re-order Point.

Default Likelihood options are derived for each site based upon local circumstances. Considerable effort is made to identify costs that provide a reasonable estimate of the costs involved. It will be convenient to use these values for the majority of items. There is nothing however to prevent the OAS user from substituting specific values as the stock out cost for specific items where it is practical to do so.

Clients are encouraged to progressively fine tune the model whereby these costs are derived and to obtain accurate stock out costs from engineering staff whenever the opportunity presents.
2.1 Terminology

- **Reorder Point (ROP) or Minimum (Min):** This is the term we use to describe the stock level at which we re-order replenishment stock. The two terms are synonymous.

- **Reorder Quantity (ROQ):** This refers to the quantity of stock ordered.

- **Maximum (Max):** This refers to the maximum stock that can be held for a particular item. Typically, the maximum is calculated as ROP + ROQ.

  \[
  \text{Maximum stock holding} = \text{ROP} + \text{ROQ}
  \]

- **Lead Time:** The time that elapses between the placing of an order and the stock being replenished in the shelves.

- **Lead Time Usage:** Usage takes place after the ROP has been reached and will continue until replenishment occurs. The stock that is used during the lead time is called the Lead Time Usage.

- **Overshoot:** Where the issue size is more than one, sometimes the stock level goes below the reorder point before an order is made. This is called the Overshoot value.

It should be noted that the Maximum may never be reached in a situation where there is an overshoot situation and where usage continues after the ROP has been broken. In reality, the maximum is then:

\[
\text{Maximum achieved} = \text{ROP} - \text{Overshoot} - \text{Lead Time Usage} + \text{ROQ}
\]

The relationship of the above terms can be shown in a Saw Tooth diagram below.

- What is being used? (Forecasting – slanted line)
- When to order? (Reorder Point – A)
- How much to order? (Reorder Quantity – vertical line)
OAS displays a projected saw tooth diagram for each fast-moving item on the What-If Tab.

To obtain the best or optimum answers, OAS uses historical usage and user entered financial data.
2.2 Forecasting
Forecasting methods

OAS models future usage based on past unscheduled usage. The below image shows common usage profiles.

![Different usage profiles](image)

OAS provides twelve different forecast modeling methods. The best method would be the one which correlates best with actual values; however, finding the best fit is difficult without help.

The ‘BEST’ method effectively allows the user to ask OAS to select the best forecast method. OAS uses the eight methods below with the red asterisk, and then creates a best fit hybrid.

<table>
<thead>
<tr>
<th>Code</th>
<th>Name</th>
<th>Typical Parameter</th>
<th>Characteristics</th>
<th>Family</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAvg</td>
<td>Moving Average *</td>
<td>12 months</td>
<td>simple, seeks average</td>
<td>smoothing</td>
</tr>
<tr>
<td>Sexp</td>
<td>Single Exponential Smoothing *</td>
<td>0.15</td>
<td>seeks average</td>
<td>smoothing</td>
</tr>
<tr>
<td>DExp</td>
<td>Double Exponential Smoothing *</td>
<td>0.15</td>
<td>seeks avg &amp; trend</td>
<td>smoothing</td>
</tr>
<tr>
<td>TExp</td>
<td>Triple Exponential Smoothing *</td>
<td>0.15</td>
<td>seeks avg, trend &amp; season</td>
<td>smoothing</td>
</tr>
<tr>
<td>AdSm</td>
<td>Adaptive Smoothing *</td>
<td>-</td>
<td>self-modifying response</td>
<td>smoothing</td>
</tr>
<tr>
<td>LSqr</td>
<td>Least Squared Fit *</td>
<td>-</td>
<td>straight line fit</td>
<td>line fitting</td>
</tr>
<tr>
<td>SmlS</td>
<td>Smoothed least squares *</td>
<td>-</td>
<td>curve line</td>
<td>line fitting</td>
</tr>
<tr>
<td>TrSe</td>
<td>Trend seasonal</td>
<td>-</td>
<td>line fit with season</td>
<td>line fitting</td>
</tr>
<tr>
<td>SmTSe</td>
<td>Smoothed trend seasonal</td>
<td>-</td>
<td>curve fit with season</td>
<td>line fitting</td>
</tr>
<tr>
<td>Dint</td>
<td>Demand Interval Analysis *</td>
<td>0.35</td>
<td>good for spiky data</td>
<td>slow</td>
</tr>
<tr>
<td>MTBD</td>
<td>Meantime Between Demands *</td>
<td>2 years</td>
<td>good for v/slow moving</td>
<td>slow</td>
</tr>
<tr>
<td>FxF</td>
<td>Fixed Forecast</td>
<td>100 units</td>
<td>manual forecast</td>
<td>Manual</td>
</tr>
<tr>
<td>Best</td>
<td>Best</td>
<td>-</td>
<td>expert logic</td>
<td>Auto</td>
</tr>
</tbody>
</table>

Forecasting can also be done by entering expected usage into the future and setting OAS to use this data in the calculations. Expected usage can be entered manually or imported using an Excel file - a
template file is available from Oniqua. See section 6.2.2 for more information on importing projected demand.

Note that the calculation for slow moving items always uses the MTBD forecast method.

Forecast Variance

Variance is a measure of how sure we are that the forecast usage is correct.

- A low variance (e.g. < 100%) means we are sure that the forecast is correct.
- A high variance means that the usage can change a lot.

Stock outs may occur more often for items with high variance and if the usage increases significantly. Such items will tend to have a higher safety stock, which is dealt with in the next section.
2.3 Reorder Point

We expose ourselves to a stock out risk every occasion that the ROP is broken. The correct Reorder point ensures that we minimize stock outs, but finding the appropriate ROP is where we need help. OAS uses the Forecast Usage and determines how likely it is that the stock out will occur. It then tries to minimize the event of a stock out occurring.

Using the Cost Model, OAS places a dollar value on the stock out risk and then balances the stock out risk with the holding cost. This is simply a matter of multiplying the percentage likelihood of a stock out occurring by the total stock out cost.

OAS Calculation

OAS balances stock out risk against holding cost.

The Reorder Point is made up of:

- **Overshoot** – which we have no control over
- **Lead Time Usage** – which we have some control over
- **Safety Stock** – which we can control

![Graph](image)

Reorder Point =

Overshoot + Lead Time Usage + Safety Stock

Overshoot

This is the amount by which the issue that caused the ROP to be broken will take the stock on hand under the ROP.
An average issue size greater than 1 unit might ‘overshoot’ the Re-Order Point. OAS calculates overshoot as the average units by which this is expected to occur (based on historical issue data), and gives some weight to this measure in Optimal ROP calculations.

Where the Average issue size is one, the overshoot will be zero.

**Overshoot:**

When the SOH falls below the ROP due to an issue.

Lead Time

This is the time it takes from breaking the Reorder Point to ordering new stock to when it arrives from the supplier. This includes internal time to place the order, supplier time to deliver the item and the time it takes to freight the item to the required store.

Lead Time Usage

This is the estimated amount of stock that will be issued during the Lead Time. LTU will vary due to variances in usage as well as variances in lead time.

The principal reason for holding a minimum stock is to ensure that stock issues can continue to be maintained during the lead time. In fact, some crude inventory management systems simply set the minimum stock to the usage that is estimated to occur during the lead time.

OAS will calculate Lead Time usage as shown in the example here. (i.e.: Lead Time Usage = Total Lead Time (in weeks) X Average weekly usage.)
Safety Stock

In some ERP systems safety stock can have a different definition, but in OAS, Safety Stock is a calculated estimated units of stock remaining after a purchase order is expected to be received. The key word here is ‘expected’ – of course, usage and lead time forecasts cannot be 100% accurate, and therefore a buffer is required to meet service level targets – a buffer (safety stock) that is minimizes stock out costs, without exceeding the added holding costs that are incurred.

OAS will have a different calculated safety stock for Current ROP and Recommended ROP, and will also take usage and lead time variance into account in finding what is optimal.
2.4 Reorder Quantity
Finding the right reorder quantity is important to ensure that you do not hold too much (causing surplus) or too little (causing stock outs) in stock. Certain factors must be considered when determining the right amount.

Holding Consideration

Holding costs are a result of:

- Interest Rate/Rate of return
- Warehouse cost
- Obsolescence
- Losses and adjustments

The total annual holding cost for each item can be calculated by multiplying the average number of items held in stock by the item price times the holding cost percentage.

\[
\text{Annual holding costs} = \text{Average stock value x holding cost} \\
= \text{Average SOH x price x Inv. Holding cost (\%)}
\]

Purchasing Consideration

Since resources are required to purchase an item the cost of using these resources needs to be considered whenever an item is restocked. The costs of these resources can be calculated and a dollar value of processing every line of a purchase order can be reliably estimated.

Replenishment costs are a result of:

- Process reorder report
- Source goods
- Send order
- Routine expediting
- Receive goods
- Pay invoice
OAS Calculation

OAS balances purchasing cost against holding cost

Rule 1: The less we hold, the less the holding cost

Rule 2: The more we purchase, the less the purchase cost per item

OAS balances out the two rules to find an optimum order quantity.

Balancing the Holding and Purchasing costs is called the Economic Order Quantity and is represented with the following formula:

\[
\text{Replenishment costs} = \text{Number of orders} \times \text{cost per order} = (\text{Annual usage} \div \text{ROQ}) \times \text{cost per order}
\]

Example:

Holding cost is 20% per item

Purchasing cost is $20 per order

Usage is 120 per year

<table>
<thead>
<tr>
<th>Order Qty.</th>
<th>Orders per year</th>
<th>Purchasing cost</th>
<th>Holding Cost</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>6</td>
<td>$120</td>
<td>$20</td>
<td>$140</td>
</tr>
<tr>
<td>40</td>
<td>3</td>
<td>$60</td>
<td>$40</td>
<td>$100</td>
</tr>
<tr>
<td>50</td>
<td>2.4</td>
<td>$48</td>
<td>$50</td>
<td>$98</td>
</tr>
<tr>
<td>60</td>
<td>2</td>
<td>$40</td>
<td>$60</td>
<td>$100</td>
</tr>
<tr>
<td>80</td>
<td>1.5</td>
<td>$30</td>
<td>$80</td>
<td>$110</td>
</tr>
<tr>
<td>100</td>
<td>1.2</td>
<td>$24</td>
<td>$100</td>
<td>$124</td>
</tr>
<tr>
<td>120</td>
<td>1</td>
<td>$20</td>
<td>$120</td>
<td>$140</td>
</tr>
</tbody>
</table>

When you consider the costs associated to purchasing and holding, the combined costs bottom out at the optimum ROQ as 50 items, with a total cost of $98...the economical lowest cost.
2.5 ROP and ROQ Methods

OAS provides the following reorder point and reorder quantity methods which can be selected by the user:

ROP Methods:

- **Current Value**: The ERP value will be used, and no optimization will be done.
- **Define Value**: The user can set the ROP / Minimum value required. No optimization will be done. This must be used with the ROQ Method ‘Define Value’.
- **Optimal**: OAS will calculate the optimum value. This is the recommended reorder point method.
- **Regional Safety Stock**: OAS will optimize by considering usage in other regional stores. Other regions must be configured for this option to be effective, and the ROQ Method must be set to ‘Regional Safety Stock’.
- **Safety Stock Units**: OAS will set the safety stock units and calculate the ROP using Lead Time and Overshoot parameters only.
- **Weeks of Safety Stock**: OAS will set the safety stock based off the forecast usage and the number of weeks required. The ROP will be set using Lead Time and Overshoot parameters only.

ROQ Methods:

- **Current Value**: The ERP value will be used, and no optimization will be done.
- **Define Value**: The user can set the ROQ / Maximum value required. No optimization will be done. This must be used with the ROP Method ‘Define Value’.
- **Optimal**: OAS will calculate the optimum value. This is the recommended reorder quantity method.
- **Economic Order Quantity**: While this is the normal ‘optimal’ setting, a parameter can be used to set the value to a specified percentage up or down.
- **Fixed Order Quantity**: The user can set the ROQ / Maximum value required. No optimization will be done. This is the same as Define Value but without the restriction of the ROP Method being fixed as well.
- **Lead Time Usage**: The ROQ will be calculated as the Lead Time Usage multiplied by a factor.
- **Number of Purchase Orders**: This calculates the ROQ / Maximum such that a particular number of purchase orders are raised in a year.
- **Periods of Usage**: This calculates the ROQ / Maximum to cover usage for a particular time period.
- **Regional Safety Stock**: OAS will optimize by considering usage in other regional stores. Other regions must be configured for this option to be effective, and the ROP Method must be set to ‘Regional Safety Stock’.
2.6 Service Level

In a real-life inventory one can expect OAS to set items to a wide variety of service levels. Generally, the high cost items with low business impacts will have a relatively low Customer Service Level, whilst conversely the lower cost items with a significant Business Impact will have high Service Levels.

In most cases when OAS optimizes an inventory for the first time the overall customer Service Level will be found to increase whilst the Inventory value will decrease.

Example:

Holding cost is $60 per item
Stock out cost is $3000 per incident

<table>
<thead>
<tr>
<th>Safety stock</th>
<th>Holding value</th>
<th>Chance of stock out</th>
<th>Stock out risk value</th>
<th>Total Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>50%</td>
<td>$1500</td>
<td>$1500</td>
</tr>
<tr>
<td>5</td>
<td>$300</td>
<td>20%</td>
<td>$1600</td>
<td>$900</td>
</tr>
<tr>
<td>10</td>
<td>$600</td>
<td>5%</td>
<td>$150</td>
<td>$750</td>
</tr>
<tr>
<td>15</td>
<td>$900</td>
<td>2%</td>
<td>$60</td>
<td>$960</td>
</tr>
</tbody>
</table>

OAS balances out the two rules to find an optimum Safety Stock of 10, with a minimum cost of $750.
3.1 Understanding the OAS Process

OAS is an inventory management system which interfaces with the corporate materials management system. At regular intervals (usually monthly) the OAS database is updated by the most recent data from the ERP system. OAS is not an on-line interface, i.e. changes in OAS do not directly produce changes in the Host ERP system unless the upload process is conducted. There is an advantage to this in that the software can more user friendly, and the user can experiment with changes safely without interfering with the Host ERP system.

The monthly process is:

- Data is downloaded from the corporate materials management to OAS
- Automatic ‘Optimization’ occurs to adjust reorder settings
- ROP/ROQ settings are uploaded

Note that ROP/ROQ settings can be reviewed before they are uploaded, or they can be set to be updated automatically based on user defined rules.

The OAS software will be quite different to the ERP system as, while it must be consistent with the requirements of the ERP system and the needs of the client, there is much more to the database structure due to the functionality and operational capabilities.

OAS provides a variety of functions as per the following diagram:
Interfacing with the ERP

Interface software (connectors) are used to manage the update of OAS data with current information from the ERP system as well as to control the upload of the OAS recommended Stock Recommended Order Points (ROP), Recommended Order Quantities (ROQ) or Minimums and Maximums.

The connectors populate what is called INPUT tables from a variety of ERP table structures. This population is selective and generally only includes relevant fields from the ERP system that contribute to the forecast requirements of the inventory records and the associated review processes.

Data is stored in the following tables:

- Stock Record or Material Master records – Set Item table
- Consumption or Issue transactions – Base Issue table
- Supplier or Vendor Receipt transactions – Base Receipt table
- Supplier or Vendor records – Set Supplier
- Group Classification records – Group Class table
- Equipment records – Equipment table
- Application Parts Lists or Bills of Material records – APL table
- Part Number records – Part Number table
- Cross Reference records – Cross Reference table
The Set Item table is the visibly apparent inventory that can be viewed from the work bench. Links to the other tables provide additional information related to the inventory under review.

Security

OAS provides various levels of data security. Users view data under a controlled environment.

- Functional area access
- Menu option access
  - Predefined roles or User-defined roles
- Data access
  - Read, Write or None
3.2 Introduction to Oniqua Analytics Solution (OAS)

Logging on to OAS

Please see OAS Cloud Startup Guide for detailed access instructions

Go to http://[clientname]. oniqua.com to log on.

Enter assigned username (generally, first name initial and surname) and the password.

Once in cloud, there should be two OAS environments for use; production and sandbox. Double click the appropriate icon to open OAS.

OAS uses cloud sign on credentials to sign users in automatically, therefore, username and password are not required again to sign into OAS.
3.3 Working with Groups

Sets

Sets represent logical groupings of data for the purpose of analysis. For example, the Sets may be defined by geographical location and/or by entity type. Alternatively, the Sets may be defined according to the responsible party. The Sets appear in the Tree View Pane.

In addition to distinct Sets, OAS creates a default 'All' Set which allows analysis across multiple Sets. This Set combines all data from Sets of the same Set Type (e.g., All Inventory, All Equipment, All Supplier, etc.)

Set Types

A Set Type is an identifier for the type of data contained. In OAS version 6.4, these sets are named and displayed as shown below. Equipment Performance represents equipment and functional locations. Maintenance Effectiveness represents standard jobs and preventive maintenance plans. Inventory Optimization represents parts catalog. Procurement Effectiveness represents parts catalog item-to-contract. Supplier Performance represents suppliers. And finally, the Supply Chain Effectiveness represents procurement transactions from order to invoice.
A group is a way to access set data in OAS. These groups can be created using various methods and filtering to limit the data view. OAS also allows users to modify the data and make changes if users have appropriate permission.

Creating data groups

When a user opens a Group, OAS creates a copy of the Group which allows editing and analysis of the data. The Group can also be updated to the data Set when it is saved and returned.

![Diagram of Group lifecycle](image)

Saving/updating a Group is distinct from the process of returning a Group. Saving a Group updates changes from the copy to the source Group. Returning the Group involves returning the records in the changed Group to the source Set from which they were copied.

OAS also provides a way to manage Groups for users. Changing the Group name, sharing the Group(s) with other users, or combining multiple Groups into a single Group can be done by using the FILE command or right clicking on the group.
From Work Queue

The work queues can be set up at global level or at individual set level to provide each business units to have their own unique work queues and priorities without affecting other business units.
Highlight the data set from the left window pane and select a work queue from the work queue tab and double click to create and open the group. The selected work queue must have at least 1 record in the “outstanding records” count column to create a group.

The data group created appears on both the left pane window and within the details section of the work bench.
Right click on the group and select Rename Group to change the name of data group if appropriate.

From control segment

To create a data group via control segmentation, right click the appropriate data set and click on Control Segments.
The resulting view is the distinct value dialog box. Select desired records by checking the boxes on the select column and click the create group button.

From new group creation dialog box – all, custom, single

To create a data group via new group dialog box, right click the appropriate data set and click New Group which will prompt a Create Group dialog box.
To create a data group representing the entire data set, select ALL and enter user initial prefix into the data group name and click the CREATE button. Note that the group option for Returnable is unchecked unless the group creation is for the purpose of data modification or data exporting. The group can also set to open immediately upon creating.

To create a data group for a single record, select SINGLE, enter or select stock code and click OK. The “open immediately” checkbox will name the group and open the single data group automatically. Note that the group option for returnable is unchecked unless the group creation is for the purpose of data modification or data exporting.
To create a data group using a custom library list, select custom and use the Selection Library dropdown box list to select a pre-specified data grouping, then click the CREATE button. Note that the group option for Returnable is unchecked unless the group creation is for the purpose of data modification or data exporting.

Modifying existing custom library list
Right click on the desired data set and select New Group. Select the appropriate custom group from the selection library, then click the CUSTOM button to prompt the Custom Selection dialog box. If modifying an existing field name, then select the field parameter to be modified and click the EDIT button on the custom selection dialog box. Otherwise, click the ADD button to define additional filtering criteria.

Existing selection parameters are already stated on the Selection Definition dialog box. This example is for adding Control Segments as a selection criterion. Highlight the existing material group and click DELETE button to remove. Enter or select desired material group and click ADD button to add. Once completed, click OK button to save & exit.
The Custom Selection dialog box now shows the modification. Modify other existing field parameters or add new field parameters as appropriate. If the modified data grouping is to be used in the future, save it to the custom library list by clicking the DISC icon next to Selection Library.

Provide the name to the newly modified data grouping or select an existing name to replace by clicking the drop-down box. Enter an appropriate description as reference and click the OK button to save it for immediate & future use. If the new modification is saved to an existing name, the user must click the OK button when prompted with over write existing name. Note that Share with other users is unchecked. This will limit the availability of this data grouping to other users.

Click OK to accept from Custom Selection, then click the CREATE button to create a data group.

Creating a new custom library list
Right click any data set and select New Group. Then click the Custom button to prompt the Custom Selection dialog box and click ADD to enter selection criteria.

Select the field to filter from one of three field selection boxes on the left (Favorite Fields, Recently Used Fields or All Fields). Then select the filter criteria (Equal, In Range, In List, etc.). Following example for filtering multiple material numbers (stock code). One can enter one stock code at a time or click the advanced button to copy and paste multiple stock codes at once.
Open an Excel spreadsheet with multiple stock codes and copy them. Then go to the ‘Advanced in the list’ dialog box and click the PASTE button which will place the stock codes into the box. Click OK to close and go back to Selection Definition dialog box with new list. Note that data separator is marked on “carriage return line feed” and be sure to remove any trailing empty spaces from the stock codes once they are pasted into Advanced in the list dialog box.

Once the stock codes are brought back to the Selection Definition dialog box, click the OK button to save & exit.
Notice that the number of items on the list. If data grouping is to be used in the future, save it to custom library list by clicking DISC icon next to Selection Library.

Enter the new name and description. Check the Share with Other Users box if the list is allowed to use by others; otherwise, leave it unchecked. Click OK to complete and return to the Custom Selection dialog box with the new saved name. Click OK to exit back out to Create Group.
The newly created group list is now displayed and available for immediate/future use in the selection library list. Click CREATE to create the data group.

Open data group to view data from OAS workbench

Double click the data group or right click the data group and select “open group” to access data.
The following OAS workbench view will appear when a data group is opened.

Working with data groups

Renaming a group
Changes the name of the Group as displayed in the Tree View Pane and in any other references to the Group. After renaming a Group the Tree View Pane automatically refreshes to display the new name.

**Closing a Group**

If you have not saved changes prior to attempting to close a Group, you will be prompted to save changes.

- Click on OK to save changes and close the window.
- Click on No to exit the window without saving changes.
- Click on Cancel to return to the Group Window without saving any changes.

**Deleting a Group**

Deletes the Group from the Tree View Pane. After deleting a Standard Group, any locks are removed from the Set. After deletion, the Tree View Pane is automatically refreshed to remove the deleted Group and display the new hierarchy.

**Returning a Group**

Involves returning the records in a modified Group to the Set from which they were copied. You should do this when you have finished making changes to a Group and/or results have been generated. A Group can only be returned when:

- The Group is not in use i.e. the Group must be closed.
- The Set from which the Group was created is on your Workbench (i.e. the Group appears in the Tree View Pane under its source Set i.e. is an External [New Item] Group).
- The Group is owned by you.
- The Group was created as a returnable group.
- You have the necessary permissions to return a Group (or permissions sufficient to override the ownership requirement).

**Refresh Group**

If a group is out of date due to a month end run, or you have made changes you don’t want to keep, you can use the menu option Refresh Group. This will recreate the group using the parameters used to create the group in the first place. Data will be copied from the Set into the group. All existing changes will be lost, but you will have a fresh copy of the data.

**Share Group**

OAS enables you to share or stop sharing groups with other users. By default, Groups are not shared. Shared Groups will appear on the Workbench of those users with whom the Group has been shared. The Group icon will appear with a hand underneath it indicating its shared status as shown below.
You can manage access to the shared Group by assigning either read or write privileges to users. A user with write permission can save changes to the Group.

OAS will not allow a group created from the “All” Set to be shared as permissions may be different per set.

The hand graphic next to the group indicates a Shared Group
4.1 Workbench Layout

The primary view of OAS is the Workbench.

The Workbench consists of:

- **Functional Areas** – these are shown depending on the appropriate licenses of the user.
- **Nodes** – these are configurable ‘place holders’ to group the data e.g. by division, geographical area etc.
- **Sets** – these are configurable arrangements of the data. Data is arranged, called partitioning, into SETs. The Sets can be configured using any field(s) in the item data e.g. by District code, buyer code or other.
- **KPIs** – are configured and show data relevant to each Set highlighted
- **Work Queues** - are configured and show work required
- **Metrics Viewer** – shows user selected metrics

The KPIs, Work Queues and Metrics are on separate tabs on the left-hand side of the workbench.

Menu options are across the top and status is below. Shortcut icons are also available on the toolbar on the top.
The Workbench shows the enterprise view of data at the top functional area node. The Sets below are a 'view' of the data created from business rules. Data cannot be viewed within the Sets themselves.

When a user wants to view data, a copy is made into a Group. The Group is used for data review, what-if analysis etc., and can then be used to update the Set.
4.2 Navigation in the Group View Window
When a group is open the need to navigate from one record to another record is very useful.

Navigation is done using menu options and/or toolbar options.

- **FIRST, PREVIOUS, NEXT, LAST**: Buttons for navigating. Also available on the menu options under the View menu
- **TABLE/FORM**: Records can be viewed in either tabular or form views on most tabs. Some tabs are limited to only one view.
- **TAG**: A way to mark a record so that you can review it again later. Records can be tagged on the header, via the Edit menu or in table view. Records can be untagged as well.
- **PREVIOUS TAGGED, NEXT TAGGED**: Buttons for navigating to the previous or next TAGGED records.
- **HIDE**: A way to hide a record from view when it is temporarily not required. Records can be unhidden as well. See the menu options.
- **SELECT**: A utility which allows user defined selection criteria. Selected records can be tagged or hidden or untagged. Note: Selection options were introduced when creating a group. The user can also use selection Libraries for selections used over and over.
- **SORT**: Records can be sorted by any field, e.g. by stock code or description. Sorting can also be done by clicking on a column header in table view. A second click will sort by descending order.
- **GOTO**: Go to a particular stock item as entered by the user.
- **COLUMN VIEWS**: Column sizes can be changed and positions moved. These can be reset using ‘Reset Column Views’.
Information about the group is shown at the bottom of the Group window. This shows, the sort order, the ‘Returnable’ status of the group, the number of visible records, the number of hidden records and the number of tagged records.
4.3 Data Visibility

OAS provides additional functions to view more information about each item or about the item characteristics. The following menu options are available when right clicking on a data field:

**Properties**

Properties shows information on the field including the database name. If any business rules are applied to the field the Task Details button is enabled – which shows the rules which were used to set the field values.

**Distinct Values**

Provides a list of distinct values found in the field within the whole group. Records can be tagged, untagged and hidden using this feature. The window provides a table of values which can be copied to Excel using the Copy Special function.
Copy and Copy Special

Will copy the highlighted record(s) and database field names from a Distinct Values window or Table View for pasting to Excel.

Copy Special allows the user to specify field selections, field headings, (rather than database field names), and the translated values rather than just the underlying codes. Copy Special also allows field selection for fields not in the current view or tab. If you have a favorite or common selection, you can save the selection to a selection library for use next time it is required.
4.4 Main Header Display – Key stock item parameters

Main View has the key item information such as criticality, replenishment level comparison, unit price, lead time, issue size and available stock quantity in inventory. The radio buttons [...] next to the field navigates to a corresponding detail dialog box.

**Unit price**

The Unit Price field on the Main Header has a navigational button [...] that displays the unit price used (last, average, manual, or repair), the unit of issue, and the unit price trend.

**Lead Time**

The Total Lead Time field on the Main Header has a navigational button [...] that displays the lead time (average, manual or stated=planned delivery time), the lead time distribution, and corresponding receipt history for the item.
Issue Size

The Issue Size field on the Main Header has a navigational button [...] that displays the issue size (auto, manual), the issue timeline, and corresponding issue transaction history for the item.

Available Quantity

The Available Quantity field on the Main Header has a navigational button [...] that displays the inventory status of item’s quantity allocation (stock-on-hand, in transit, on-order and reserved).
Date last Exported

The Date Last Exported field on the Main Header has a navigational button [...] that displays the export history of OAS data to 1SAP for the item.

Edit, navigational and command icons

Commonly used commands can be accessed by clicking EDIT or by the icons on the main display.
4.5 Workbench tabs

Forecast Tab

The forecast tab has the historical monthly usage in a table format and a graphical representation. The view is switched based on the tab selection on left – Usage or Graph. Usage is totaled per month from the unscheduled issue usage.

Forecast Tab Options

There are options that can be viewed and changed, then the Recalc engine is run to re-calculate the forecasted usage based on the new values. The options are listed below:

- **Usage Periods**: This is generally the number of months that have passed since the item was created. This can be changed to exclude certain past values but it is not recommended.

- **Forecast Periods**: This allows future usage to be entered and calculated and can be changed up to 24 periods. The red line on the graphic shows the future forecast usage.

- **Forecast Method**: This should be set to ‘BEST’ in most cases. A parameter option is available for other methods.

- **Forecast Mode**: This tells the Forecast Engine what values to use. By default, this is the actual usage, but if required, this can be changed to use projected values as well. Projected values can be entered manually or from importing data from Excel.
- **Forecast Usage**: This is the value used on the Saw Tooth graph.

- **Clipping Code and Limit**: Some values may be way above the ‘normal’. OAS will clip these so that they are excluded from the forecasting. The Limit value will show the point at which values are clipped. To include values, change the clipping code to ‘None’ and press the ‘Recalc’ button. If you want to use a manually set Limit, then change the Clipping code to ‘Manual’.

- **Forecast Variance**: See notes in section 2.2.

- **Demand Profile**: If we know that usage will change by a factor, e.g. 50%, we can use the demand profile to simulate this situation, and recalculate the expected forecast. Profiles can be applied to several records.

- **Forecast Factor**: Set a ramp-up or ramp-down factor on individual materials or groups of materials to adjust the recommended optimal inventory levels. For instance, a ramp-down factor can be defined on materials used to maintain equipment planned to be decommissioned in the near future.

Note: The Factor due date must be set and the item/s recalculated for the changes to be applied.

**Codes Tab**

The Codes tab contains the standard inventory assigned codes and the item classifications.

**Results Tab**

The Results tab contains the replenishment calculation method, cost model used, and OAS calculation results. It also contains the export selection indicating the export status of the item i.e. whether to export the values to the Host System, or if the export has already been done.
Comparison Tab

The Comparison tab contains the key inventory performance comparison between current replenishment levels against the OAS recommended replenishment levels.

Service level Tab

The Service Level tab contains a view of item’s current service level difference from OAS recommended service level, current service level, and recommended service level for single or multiple item records.
Tag Selection

Records can be tagged by selecting the table cells and clicking “Tag Selection”. Select All and Clear All buttons will alter the records selected in the table.

Summary Tab

The Summary tab shows a summary of the inventory performance measures based on the current replenishment level.

Info Tab

The Info tab contains OAS summary of customized fields and current inventory status. It also contains navigational buttons to display where used, BOM, manufacturer/OEM part numbers, and alternate part number associated with the item.
Description Tab

The Description tab has the item description and the manufacturer or OEM part references.
Main Tab

The Main tab shows a spreadsheet format display of the detailed data from the ERP and OAS calculated results.

What If Tab

The What If tab shows a graphical representation of simulated inventory quantity trend and order frequency of current and recommended replenishment levels for active items. The slow-moving items (moving code zero or one) will display Zero-One-Two analysis rational for recommending the replenishment level.
Approvals Tab

The Approval tab has the approval decision and process steps required to export an item record from OAS to the host system.

Custom Tab

The Custom tab includes additional user definable fields which are populated with customized calculations or coding as needed.
Baseline Tab

The Baseline tab provides users with:

- visibility of inventory value over time, for a single material or group of materials.
- ability to define baseline month for what-if analysis purposes
- visibility of how inventory quantity changes affected the overall inventory value over time.
- visibility of inherited and unwanted stock events (e.g. inherited project stock) that impacted on inventory KPIs.

The tab is updated as the user moves through records.

Please Note that all values are expressed in the local currency by default. However, when multiple records with mixed currencies are grouped together, OAS will convert the Inventory Value and express it as per the defined Corporate Currency.
Inventory Value

The monthly Inventory Value is calculated from the defined Baseline Month to the last Periodic Update month and is plotted on the graph for Single, Tagged or All items within the group. The inventory Value is represented by the light blue area on the chart.

New Inventory Value

This is calculated in the same way as the Inventory Value, however it only involves items with historical data post the Baseline Month. The values for this calculation are represented by the light-gray area on the graph.

Inventory Value using Current Maximum

This calculation shows the expected inventory value based on the Current Maximum. The values for this calculation are represented by the light-blue color series and are hidden by default. To view this series, hover the mouse over the toggle button within the legend located at the right side of the graph.

Inventory Value using Baseline Average Price

This calculation shows a simulated Inventory Value (using either Stock-On-Hand or Available Quantity) with fixed baseline Average Price and monthly variable quantity. It shows how much Inventory Value you would have had if Average Price had not changed over time, therefore it highlights Inventory Value changes due to inventory SOH or Available Quantity changes. The values for this calculation are represented by the dark-blue color series and are hidden by default. To view this series, hover the mouse over the toggle button within the legend located at the right side of the graph.

Inherited Inventory Events

Inherited Events refer to stock that was returned to inventory or received in store not as part of regular inventory replenishment. For example, a large project or maintenance project may have had 'leftovers' which are either returned or sent to inventory for new material masters to be created in order to electronically 'receive' the corresponding inherited quantities. For most clients, these are issues with a negative issue quantity and they can be classed differently depending on the ERP and established business processes.

For every month where at least one 'Inherited Inventory Event' was identified, an orange point is added on the chart. (Please note that the Inherited Inventory Event pertains to the date on the horizontal (x-axis), and bears no relation to the vertical (y-axis) values on the graph).
Custom Baseline

A baseline date can also be manually set by right clicking on the chart and choosing the 'Set [Date] as Baseline Month' option from the context menu.
Distinct Values allows you to view the data distribution of a specific field. Right click on any data field and select Distinct Value to display the data distribution and corresponding graph display by selected field ranking.
Tag & un-tag records

Tagging & un-tagging records is used to mark and filter specific data records.

Record(s) can be tagged or untagged manually by clicking the Tagged box to check or uncheck the records.

The record(s) can also be tagged using Edit/Tag command.

The record(s) can also be tagged using Distinct Value. From within then desired distinct value box, select the appropriate records to tag by clicking the select boxes on the left, click SELECT GROUP ITEMS, select Tag then click OK and CLOSE.
Record(s) can also be tagged using SELECT command by right click on the field to be used for selection.
The custom selection dialog is prompted with the field criteria for selection. This example shows Total Lead Time = 33 days. If the criteria are acceptable, click OK. Otherwise, click EDIT to change the selection criteria for tagging.

Modify Selection Definition accordingly and click OK. Example shows use of lead time range between 45 to 60 days.
Custom Selection dialog box now shows the change. Click OK to complete the tagging.
Hide & unhide records

OAS provides the ability to hide & unhide records temporarily to focus on certain records. Record(s) can be hidden or made visible using Edit/Hide command.

Record(s) can also be hidden using Distinct Value. From within then desired distinct value box, select the appropriate records to tag by clicking the select boxes on the left, click SELECT GROUP ITEMS, select Hide then click OK and CLOSE.
Record(s) can also be hidden using the SELECT command by right clicking on the field.

A custom selection dialog is prompted with field criteria for selection. This example shows items with Unit Price = $33.50 to be hidden. If the criteria are acceptable, click OK. Otherwise, click EDIT to change the selection criteria for tagging.

Modify Selection Definition accordingly and click OK. Example shows the unit price greater than $100.
Custom Selection dialog box will then show the change in selection criteria. Click OK to complete the hiding of selected records.

**Field column size and location adjustment**

The field column size or location can be adjusted by click and dragging per each user’s preference. This feature is ideal for viewing the data as well as copying the OAS data into an Excel spreadsheet.
Block replace records

Field values can be changed one at a time or by multiple. Once records are selected & tagged, right click on the field to be changed. When the Block Replace dialog box prompts, enter desired field value and click OK. The example below shows the Responsibility field being replaced with “10012” for 215 tagged records.

Recalculate the results after modifying the field parameter(s)

Any of the key field parameters can be changed to simulate a what-if scenario. This example shows modifying historical usage period from 60 months to 24 months to determine the forecast usage. Recalculate allows OAS to use the new parameter(s) to re-determine new replenishment levels and the corresponding cost impact.
Exporting OAS data out to an Excel spreadsheet

The following procedure is used to copy desired OAS data into an Excel spreadsheet for reference and/or reporting purposes.

Change the formatted data display to table format by clicking the table icon.
Press CTRL-A to select all records. The records can also be selected manually by pressing CTRL and clicking on the appropriate records.

Right click on any highlighted field or click Edit to select the Copy Special command.
Select the desired fields to copy by checking the select box then click OK to copy the data into a clipboard.

Open an Excel spreadsheet and paste the data from OAS using right click, then Paste or CTRL-V.

Go to Insert, Table on Excel command to convert pasted data into a table format. This allows Excel to perform filtering for each field.
In OAS version 6.4, the user can access entire available fields without going to separate TABS by selecting “Show All Fields”.

Additionally, the user can save the copy special to the library for repeated use. The user also has an option to make the copy special library list to be available to other users by checking the Public Flag box.
OAS data can also be copied from the Distinct Value display. Click Copy All Distinct Values button to copy the display data, then paste it into Excel spreadsheet. The user can also select the records to copy by using CTRL key to select and copy & paste them into Excel.
Protect fields

OAS allows users to override a value calculated by an Autotask, e.g. where a user wants to enter their own purchasing cost and then ‘protect’ the field from being overwritten by the cost model. This can be done protecting one record, all tagged records or all records in the group. Overwriting Autotask values is not recommended unless special circumstances are agreed upon.
4.7 Reviewing results
The goal of OAS is to provide optimized recommendations for each stock item. However, while OAS performs the optimization, the user is still involved in accepting or rejecting the optimizations. Visibility and understanding of the recommendations is an important step in updating the ROP/ROQ values (or Min/Max) in the ERP system.

Quick what-if analysis can be achieved by updating the ROP and ROQ Methods, the costs and other key fields across many items at once. Results are seen on various tabs in the group view.

Current and recommended values
The Header Tab provides visibility of the Reorder Levels (ROP/ROQ or Min/Max related values) which have been imported from the ERP and those which will be exported back to the ERP.

<table>
<thead>
<tr>
<th>Reorder Levels</th>
<th>Current</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROP</td>
<td>5</td>
<td>20</td>
</tr>
<tr>
<td>Max</td>
<td>10</td>
<td>29</td>
</tr>
</tbody>
</table>

These values depend on what ROM (Re-order method) system is being used as explained below. To see the actual ROP, ROQ and Max values, go to the Results Tab or What-If Tab and click on the Reorder Controls button. This will show the Reorder Levels, safety stock, average order quantity and other related values.
The different Re-order methods are usually set when the data is downloaded from the ERP. The relationship between ROM and the import/export values is below:

<table>
<thead>
<tr>
<th>Reorder Method</th>
<th>Values Imported/exported between the ERP and OAS</th>
</tr>
</thead>
<tbody>
<tr>
<td>D0: Min/Max Implied by the ROQ</td>
<td>ROP, ROQ</td>
</tr>
<tr>
<td>M0: Min/Max (QTY &lt;= ROP)</td>
<td>ROP</td>
</tr>
<tr>
<td>M1: Min/Max (QTY &lt; ROP)</td>
<td>Maximum</td>
</tr>
<tr>
<td>R0: ROP/ROQ (QTY &lt;= ROP)</td>
<td>ROP</td>
</tr>
<tr>
<td>R1: ROP/ROQ (QTY &lt; ROP)</td>
<td>ROP + 1</td>
</tr>
</tbody>
</table>

Comparison of future expected values

The Comparison Tab shows the expected costs and values for the next year using the current settings compared to those using the OAS recommended settings.

The comparisons can be made on single items, tagged items, or all items in the group.

At a quick glance one can see how the OAS recommendations will affect the safety stock and average stock value, the turnover and Service Levels and the holding and replenishment costs. While the stock out cost is not a tangible number, it gives an indication of the risk that is expected if a stock out occurs.
Please note the following points:

• ‘Average Inventory’ is half way between the lowest stock holding and the maximum stock holding.

• For fast moving items this is the lowest of (ROP – Overshoot – Lead Time Usage) and the highest of (ROQ / 2).

• Slow moving items are slightly different as they work off days on the shelf and days off the shelf.

**Costs**

Costs can be changed by:

• Changing the Business Impact values, although the Business Impact should be changed to match the business need rather than a ‘cost’ need.

• Changing the Likelihood code.

• Changing the costs manually and protecting the fields on the Results Tab.

• Updating the Cost Model. This is usually done by supervisors and only once a year at most.

**Total Annual Costs**

The Total Annual Cost is the running costs of an item. It does not include the cost of the inventory item itself. This provides an indication of the cost of production.

The Total Annual Cost is visible in OAS by item or by a group of items. The calculation is the sum of the Stock-out Cost, the Purchasing Cost and the Holding Cost. The individual values of each item will vary depending on the values of ROP and ROQ.

**Service level information**

The Service Level Tab provides a view of the difference between the current service level and optimal service level recommended by OAS. This is also seen on the Comparison Tab but more visibility is provided on this tab. The principle idea with this Tab is to recognize that items may be overstocked and taking up holding space, or may be under stocked and a cause for stock outs.

The graph can represent single items, or tagged items, or all items in the group.
After viewing these results, it is advisable to find the items which are furthest from optimal which are at risk of stock out, i.e. those on the left-hand column. These should be reviewed and recommendations accepted as soon as possible.

To select items, click on the “All” radio button, highlight the cells in the table which correspond to the desired selection, and press the ‘Tag Selection’ button. Review the tagged items. A further refinement is to select only the cells corresponding to high business impacts.

Items on the right of optimal are overstocked items and accepting the OAS recommendations will reduce inventory for these items.

**What-if Visualization**

The ROP and ROQ values and their effects on the stock usage can be visualized by looking at the What-if Tab. This provides a saw-tooth graphic which shows the expected usage cycle of the stock item for current and recommended scenarios, usually for two cycles.

**Slow moving stock recommendations**
Where an item has little or no recorded movement then most of the forecasting and ROP/ROQ calculations described previously cease to be relevant. Items have different characteristics so different methods are used for optimizing the slow-moving stock.

There are a number of Control Segments which contain slow moving stock. Among these, the following contain items which frequently warrant optimization using OAS:

- SLOW HIGH VALUE
- SLOW LOW VALUE
- POTENTIAL OBSOLETE (Some only - The majority usually are obsolete)

The expected usage for a slow-moving item is less of a saw tooth and more of a horizontal line with a ‘missing tooth’, being where the item is used and we are waiting for replenishment.

OAS still considers the item price, the holding cost percentage and other factors in determining an optimum stock level. The Zero-One-Two analysis method provides the optimum value answers. The forecasting always uses Mean Time Between Demands (MTBD).

The below diagram is representative of the OAS Zero-One-Two analysis found on the What-if Tab:
This representation demonstrates the analysis for an item with a stock out cost of $1510 (Horizontal line) and a Mean Time Between Demands of 0.56 years. (Vertical Line)

The Lower of the upward sloping lines represents the locus of the transition points for that item where the Total Annual Cost of holding zero or holding one item is the same. Any intersection of Stock Out Cost and MTBD falling below that line would give rise to a situation where it would be most cost effective not to stock the item.

Likewise, the upper of the upward sloping lines represents the transition between a situation where, below the line it is more cost effective to hold one, and, above the line it is more cost effective to hold two.

The What If tab is automatically configured to display this analysis for any item where the Moving Code is 0 or 1.

This What-If tab is particularly useful in enabling users to see the stocking ramifications of assigning particular levels of Business Impact (and hence Stock Out Cost) for their estimate of the MTBD.

Set size considerations

OAS has the means whereby a set size can be stipulated for an item. The thinking behind this is that it is pointless holding a quantity for these items other than multiples of the set size. Examples of items where set sizes may be applied are as follows:

- Oars come in sets of 2
- Sparkplugs for a 4-cylinder motor are replaced in sets of 4
- Explosive headed bolts securing a blow off panel (qualitrol type) may come in sets of 24

Frequently the set size considerations are subsumed by the Unit of measure. Shoes (for example) are issued with a UOM of pair and thus the set size for them will remain as 1.

Note that when set size is set to 1 then the set size calculations will be disabled.

When a set size is stipulated, the OAS Optimal settings are modified according to the formulas below:
Recommended \( \text{MAX} \) = Ceiling (Optimal Max/Set Size) \( \times \) Set Size,

Recommended \( \text{MIN} \) = Ceiling (Optimal Min/Set Size) \( \times \) Set Size – 1

Where:

- Ceiling means rounded up to the next whole number (i.e. 5.4 becomes 6)
- Recommended MAX/MIN is the recommended MIN or Max displayed by OAS
- Optimal MAX/MIN is the value of MIN or MAX that OAS would have recommended where it not for the set size calculation coming into play.

Example:

Set Size = 20
Optimal MAX = 35
Optimal MIN = 15
MAX = Ceiling (35/20) \( \times \) 20
MAX = Ceiling (1.75) \( \times \) 20
MAX = 2 \( \times \) 20
MAX = 40
MIN = Ceiling (15/20) \( \times \) 20 - 1
MIN = Ceiling (0.75) \( \times \) 20 - 1
MIN = 1 \( \times \) 20 - 1
MIN = 19

Note that where the Optimal MIN is equal to zero or the Set Size then this calculation is overridden.

**Pack size considerations**

The Pack Size is considered when the recommendations are made. Pack size rounding is usually set by global configuration.

**Issue size considerations**

The average issue size is considered when the recommendations are made. Note that OAS calculates an average, so if this is deemed to be incorrect it can be set to a manual value.
4.8 Exporting to the ERP

- The Export Process involves selecting and exporting the recommendations which we regard as acceptable changes to the ROP/ROQ (or Min/Max) values. Only a few key fields are written to a text file, typically stock codes and ROP/ROQ values. An upload program is run to update the ERP.

The Export Process can be automated through Autotasks for certain records, saving the user a lot of time and effort. However, the user is still required to review the records with exceptions.

Export process

Exporting is the primary way of passing OAS recommended values back to the ERP system. The process is as follows:

Step 1: Select records for export

- You can create a group with all the data to be exported or you can use tag/hide functionality to exclude data from being exported.
- The group created must be returnable

Step 2: Prepare records for export

- Review and tag records for export
- Use Block Replace to update the fields. This will save time as you only do the changes to ‘Ready for Export’, ‘Review Date’ and the ‘Notes’ once each, rather than for every record.
- Also, make sure the appropriate output format is selected in the ‘Ready to Export’ Block Replace window.
- Set the Export Code to ‘Do not export’ for any items which should not be exported for any reason

Step 3: Export and Upload

- Use menu option: Tools > Run Export
- Using ‘Export and Upload’ is easier if permitted
- Note that the Exported date is set when the export is complete
- The ‘Upload’ option will create the text file for the ERP
- To view the exported records, use the button next to the exported date field on the header and check the Uploaded box. Scroll to the bottom to see the last exported details

Step 4: Return the Group

- Make sure the group is returned so that changes to the fields is saved to the Set
Step 5: Upload

- Use menu option: Data Refresh > Manage Exports
- Find the exports which have not been uploaded
- Select and run the ‘Upload’ (only use if Step 3 did not upload the records)
- Upload data can be viewed using the appropriate selections and buttons

Step 6: Connector Program

- Find the text file created from the OAS export.
- Copy this to the ERP system
- Ensure the connector programs are run to transfer the exported values to the ERP

Export process security

The following security measures are put in place within the Export Process:

- The user can only export records if the group is returnable.

Exporting has two stages:

- Export: Puts data in a 'bank' for approval by a key user.
- Upload: Takes data out of the bank and makes the text file. Only key users can create the text file.

Key users can do both Export and Upload in one step.

Under normal conditions Groups should be returned to the Set. However, if the export is done in error, Groups can be deleted, the upload can be ignored and the text file can be deleted before it is uploaded to the ERP.

An Approval Process is also available whereby certain records must be approved prior to Export. Configuration must be included to provide this functionality.

Review exported data

All exported files can be viewed without creating a group. Click on command Data Refresh > Manage Exports from the main OAS screen to prompt the Manage Export Files dialog box. Select appropriate Filter Options (Exported and/or Updated) and click on the Export Table dropdown box to select exported file type (current, past or all), then click the View button. Click the Close button when finished.

“Exported” files are the stocking levels yet to be loaded into ERP system. Click the Upload button to complete the export into the ERP system.

“Uploaded” files are the item records that have been exported into ERP system.
5.1 Workflow Review Overview

A workflow should be developed with consideration to your business objectives. Some recommendations are below:

Reviews

- Review the records with status type R OK. Accept and upload these to the ERP as soon after a Periodic Update as possible. After a few months, you may want to automate this work.
- Depending on circumstances, review records with status type X.
  - X 00 indicates you are below the ROP/MIN and must order immediately
  - X 01 indicates you don’t have enough stock for this item
  - X 02 indicates you have too much stock and you need to cut back

Note: Further information on exception codes is provided in section 5.4.

Data Cleansing

- Review the records with status type D. These have data errors and will not be calculated by OAS. If the errors can be resolved, then the stock items can be recalculated and managed properly.

Removing unused stock

- Look for items which are in the obsolete control segment and review for disposal or write-off
- Look for items which are potentially obsolete and follow up with maintenance for possible disposal/write-off

Using Control Segments

- Review the Fast-Moving Items first. These will provide the quickest gains in cost savings.
- Review the Slow-Moving Items and try to get rid of excess / surplus stock. Look especially at SLOW HIGH value items.
- Identify records which should be non-stock.
- Identify Order on Demand items which OAS recommends to stock, i.e. Max or ROQ greater than 0.

The above approaches have worked well in many sites and are presented as a guide in the development of a methodology that best fits your situation.

Unless your site has a particular problem that needs to be addressed it is generally best to look for those areas where the greatest savings in inventory value can be achieved in the shortest time.
Usually the fast-moving items in the FAST-HIGH USAGE, FAST MODERATE USAGE and FAST LOW USAGE Control Segments are the best ones to attack.

A report listing Inventory Valuations by Control Segment is a useful tool to see where the greatest concentrations of inventory dollars can be found, or using the menu option ‘Control Segments’ can provide similar information.

However, some sites have problems that may have a priority greater than inventory reduction or optimization, some of these are listed below:

- Insufficient spares to ensure production
- Restructure of purchasing procedures
- Centralization of regionalized stores depots
- Regionalization of a centralized store
- Identification and disposal of obsolete and surplus stock
- Introduction of VHS or Consignment Stock
- Identifying items that should be cataloged but not stocked

Assuming that the types of problems listed previously do not exist or have been resolved, then the next step is to optimize the stock levels. In most cases, it is best to focus on items that will give the best return on investment of time. The following notes list the issues that should be addressed each month following the download from the ERP system.

It is important to put together a plan of attack with your manager and/or consultant to make a positive impact on Inventory control challenges and goals in your organization. Further information is provided in following notes.

Work Queues should also be used in order to provide workflow and focus in the review of items.
5.2 Work Queues

Work Queues are shown on the right-hand pane of the Workbench. These provide information about the highlighted Set. The Work Queues are used in OAS to maximize visibility of the status of the inventory. Work Queues can be configured to be used on all Sets on the Workbench or just for individual Sets. Some benefits of Work Queues are:

- Work Queues match key organizational objectives
- Work Queues are a quick way of finding records for review based on their status values and other fields like Control Segment.
- Managers and staff can observe the work progress

Work Queue instructions can be viewed by clicking on the document icon on the Work Queue row.

To change work Queue definitions requires a Key User with permission:

- Use menu option Configuration> Work Queues
- Select the Application Module
- Select the Work Queue required for editing

The definitions can be copied and pasted for review

Work Queue Examples

<table>
<thead>
<tr>
<th>Priority</th>
<th>Title</th>
<th>Total Records</th>
<th>Outstanding</th>
<th>% Reviewed</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Fast X01 Review</td>
<td>5,136</td>
<td>5,136</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Fast Data Exceptions</td>
<td>1,534</td>
<td>1,534</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Potential Obsolete</td>
<td>2,300</td>
<td>1,154</td>
<td>50</td>
<td></td>
</tr>
</tbody>
</table>

Each Work Queue counts the number of records which match the definition.

- The count is per selected Set
- Item records may be in several Work Queues
- Total is the count at the month start,
- Outstanding is the current count
- As items are reviewed the % reviewed numbers are updated
- A status flag is also used and will change from red to green indicating progress
- Notes and attachments can be added to the Work Queues
The workflow for using Work Queues is:

- Highlight a Work Queue and double click to create a group,
- Review and update the items,
- Save and Return the group
5.3 By Control Segment

Fast Moving

These items will be found in the FAST-HIGH USAGE, FAST MODERATE USAGE and FAST LOW USAGE Control Segments. Priority should be given to getting almost all of these items under automatic OAS control. If there are some items in the FAST-HIGH USAGE group where the past usage cannot be relied upon to predict future usage it may warrant controlling such items manually with the inventory controller contacting key users each month to obtain an indication of future usage and then setting levels accordingly. Otherwise OAS should automatically control all items. One should aim to have items in these groups automatically optimized using the Auto Export method each month.

The only ongoing work needing to be done on items in these groups should be to review new items falling into the groups for the first time as well as to check those items which were omitted from the auto batch upload due to the Status Flag being set to ‘X’ indicating an exception condition. Stock levels for items treated in this way should be uploaded to the ERP system before the next download or month end.

Items in the FAST-HIGH USAGE group should be individually reviewed when initially placed under OAS control, whilst items in the other two groups can be initially managed in groups such as by Supplier code or NATO Group Class.

Use Work Queues and selection libraries to target specific records for review each month.

Potentially Obsolete

These items generally represent ‘easy wins’ in inventory reduction. Whilst there may be some items in the POTENTIAL OBSOLETE group that fall into the categories below, most are items that should be removed from inventory. Care should be taken to identify the following categories of item which should be identified by setting the review date for the item involved and placing it in another Control Segment:

- Overlooked Insurance Spare - Reclassify the item to Insurance
- Item with a long Maintenance Cycle - Use deferred purchasing in future
- Items have been purchased on D.P. - Tell Maintenance it is stock item

A listing of each POTENTIAL OBSOLETE item should be made and sent to appropriate users. This should list items in descending order by Stock Value so the most expensive items are reviewed first.

It is recommended that approximately 30 items be sent to each user per month to avoid swamping the users with work. In this way, the POTENTIAL OBSOLETE Control Segment can be reduced to a very small number of items over a few months.

Remember that when the Review Date is set to today’s date the item is then quarantined from POTENTIAL OBSOLETE for 12 months. The item will then be managed in SLOW or SLOW HIGH VALUE during that period.
Slow High Value

This Control Segment often has a very high inventory value tied up in comparatively few items. Efforts in this area will frequently result in substantial savings as control is exercised over that 5% of inventory with a moving code of 0 or 1.

It should be noted that the infrequency of use of these items makes the purchasing details such as lead-time and price somewhat suspect. Similarly, the Business Impact of the item may warrant verification if the item has been in stock for some considerable time.

Management of these items is best governed by the moving code and the strategies for each code are discussed below.

Moving Code 1 Items
These items have some movement (albeit infrequent) that OAS can use with MTBD forecasting to predict future usage and thus make valid recommendations. There is a need to check the soundness of the usage data since recommendations on expensive stock items are being made based upon one or two issues only. In particular, watch out for stock returns causing complications.

Moving Code 0 Items
Many of these items will become POTENTIAL OBSOLETE. They have no recorded usage so OAS will assume the MTBD to be the time from the Create Date 'till now. Unless the Stock-out Cost is quite high OAS will recommend the item stock level to be zero and for it to be ordered on request. It is very important that realistic estimates of the MTBD and Business Impact, etc. be obtained from maintenance staff. These verified data can then be loaded into OAS for its recommendations.

Potential Non-Stocked items
These items have low Business Impact, readily available and infrequent usage. If the Business Impact, Availability and Moving Code are correct for such an item, it offers little value in being held as a stock item.

After validation of the criteria listed above, these items should be removed from inventory and made VHS items or Catalogued but Not Stocked.

Repairable (Rotable Items)
It is not unusual to find many millions of dollars’ worth of stock in this Control Segment, much of which is not warranted. Organizations frequently get into a routine of automatically refurbishing a repairable item whenever a worn out one is returned to the store. This is despite the fact that there is a number of the same item sitting on the shelf already repaired. It is not unusual to find 30 years of stock on the shelf. In other words, if that pump (say) was not repaired and nor were the others, it would take 30 years to run out of pumps.

OAS should calculate the ROP. The ROQ should be manually set to 1 (or the Set Size) since the ROQ is governed by the return of worn items back to store.
**Slow Items**

The much greater savings to be made in the previously listed Control Segments relegate the work done in this Control Segment to much later in the OAS cycle. It generally takes at least 6 months before an inventory manager has reached such a satisfactory level of control of the other Control Segments before work on this group can be justified. There is, however, significant value in optimizing the SLOW group and the trivial nature of many of the items in this group means that results can be achieved without laborious processing.

Business Impact, price and availability need to be verified for these items and the usage history (such as it is) checked through for anything unusual.

The OAS settings are generally quite reliable with the low price of most of these items resulting in a higher stock level being recommended than was the case for SLOW HIGH VALUE.

A detailed verification of revised stock levels with users is not warranted for these low cost, low usage items. If a detailed survey of MTBD periods was carried out for each item as was done for SLOW HIGH VALUE, then the OAS recommendations would be more reliable.

Where there is a recommendation that a plant spare be reduced to a zero stock level, the validity of the data should be checked with the key user.

---

**Other control Segments**

There will be items in other Control Segments that may warrant priority in management based on situations peculiar to your site. This must be assessed based on the importance of these Control Segments to your business situation.

There is only so much work that can be done each month. Once there are as many items as possible through the Auto Export process, one should skip around from one Control Segment to another looking for the best savings. It is a bad use of time to grind through the dregs of a particular Control Segment saving a few dollars on each item processed when there are thousands of dollars tied up in other Control Segments yet to be optimized.

A good inventory manager ‘picks the low hanging grapes first’. Your greatest savings will occur early in the project. One should always give priority to managing the Control Segment where the greatest savings are to be made.
5.4 Data Exception Management

Data exceptions are designed to highlight materials where the values being used in calculating recommended reorder values are outside the normal parameters for allowing a reliable result. Inventory Controllers should treat all data exceptions according to the type being reported and take appropriate action to remedy the field causing the error.

These exceptions are displayed in the Results tab on the OAS workbench as shown below:

Some data exceptions are considered ‘data quality’ errors where the ERP system providing the information to OAS Inventory is in need of corrective attention. Others may not be a fault in any data but relate to an abnormal usage pattern where usage is spasmodic and cannot be used for the forecast, reorder point or reorder quantity method currently set in OAS Inventory.

Requires only review and acceptance

The following table provides definitions of exceptions that require review and acceptance by Inventory Controllers.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>NNC</td>
<td>No change is recommended from current replenishment Level</td>
<td>No action is necessary.</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Impact</td>
</tr>
<tr>
<td>-------</td>
<td>----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>ROK</td>
<td>Recommended replenishment level impact total inventory value within +/- $500</td>
<td>Recommended reorder point changes are minimal (&lt;$500). Export the recommendation if acceptable.</td>
</tr>
<tr>
<td>D00</td>
<td>Do not process</td>
<td>Items designated for no recommendation, such as obsolete. These items should not be exported.</td>
</tr>
<tr>
<td>X00</td>
<td>Recommendation causes Order to be raised immediately</td>
<td>Recommended reorder points will cause a replenishment order to be raised.</td>
</tr>
<tr>
<td>X01</td>
<td>Recommendation causes inventory increase</td>
<td>Recommended reorder points will cause inventory value to increase by more than $500.</td>
</tr>
<tr>
<td>X02</td>
<td>Recommendation causes inventory decrease</td>
<td>Recommended reorder points will cause inventory value to decrease by more than $500.</td>
</tr>
<tr>
<td>X03</td>
<td>Item Recommended for Non-Stock</td>
<td>Recommended reorder points are 0/0.</td>
</tr>
<tr>
<td>X04</td>
<td>Service Level below defined thresholds</td>
<td>Recommended reorder points, if exported, will cause the service level to go below minimum required.</td>
</tr>
<tr>
<td>X05</td>
<td>Maximum Stock increased significantly</td>
<td>Recommended reorder points will cause significant increase in maximum stock quantity.</td>
</tr>
<tr>
<td>X07</td>
<td>Change Stock to Non-Stock in SAP</td>
<td>Applies to SAP only where recommended reorder points if exported will change MRP type and Lot size.</td>
</tr>
<tr>
<td>X08</td>
<td>Change Non-Stock to Stock in SAP</td>
<td>Applies to SAP only where recommended reorder points if exported will change MRP type and Lot size.</td>
</tr>
<tr>
<td>X12</td>
<td>Incomparable ROP/ROQ method used for Regional Safety Stocking</td>
<td>Recommended reorder points are in question due to incorrect ROP/ROQ method setting used for regional safety stocking. Both ROP/ROQ methods must be set to RSS.</td>
</tr>
<tr>
<td>X61</td>
<td>Forecast is extremely variant</td>
<td>Recommended reorder points are in question as the forecasted usage may not be reliable (based on excessive forecast variance)</td>
</tr>
</tbody>
</table>

If any of the above listed recommendations are not acceptable, the following preferred changes are recommended to generate new recommended reorder points. Changes can be made to one or more of the parameters mentioned below:

1 – Change the number of historical months’ usage (Usage Periods) and/or forecast method (from Best to other available option) located in the Forecast tab.
2 – Change total lead time by clicking the radio button next to the “Total Lead Time” field to prompt lead time analysis dialog box and to modify lead times.

3 – Select ROP/ROQ methods [located in the Results tab] other than “Optimal”.
Accepted Min/Max Method Combination

(If highlighted and marked with “X” then not accepted)

<table>
<thead>
<tr>
<th>ROQ/Max</th>
<th>ROP/Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Value</td>
<td>Define Minimum</td>
</tr>
<tr>
<td>Economic Order Qty.</td>
<td>X</td>
</tr>
<tr>
<td>Fixed Order Qty.</td>
<td>X</td>
</tr>
<tr>
<td>Lead Time Usage</td>
<td>X</td>
</tr>
<tr>
<td>Define Maximum</td>
<td>X</td>
</tr>
<tr>
<td>Number of PO Optimal</td>
<td>X</td>
</tr>
<tr>
<td>Period of Usage</td>
<td>X</td>
</tr>
</tbody>
</table>

Once the changes are made, perform a “Recalc” to generate the corresponding recommended reorder points by executing the command Tools > Recalc Current.

When the recommended reorder points are acceptable, mark it as “Ready to Export” [located in the Results tab] and export the reorder points by executing the command Tools > Run Export.
Requires corrective action – E exception types

EFC – Forecast Calculation error occurred
OAS encountered error during forecast usage calculation. Report the error to an OAS system administrator to resolve.

ERO – Reorder {} 0-1-2 method or divide by zero error
System error due to the item movement being classified as SLOW moving based on rolling 2-year usage but the calculated MTBD (mean time between demand) is too low. Either a result of recent movement or frequent movement prior to 2 years.

To correct this exception, follow the below steps:

1 – Change Forecast Method to “Mean Time Between Demand” in the FORECAST TAB or Usage Forecast to MTBD in the Results tab and enter a range between 1.1 to 2.5 years based on estimated demand frequency.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.
Requires corrective action – D exception types

D01 – Unit of issues (Measure) has changed
Recommended reorder points are in question due to a recent change in issue unit but the historical usage reflects the previous issue unit.

To correct this exception, follow the below steps:

1 – Highlight the past usage from the Forecast tab, then click “Edit Marked” to modify past usage to reflect new unit of issue (for example, if unit of issue is changed from each to box where there are 12 each per box, then past usage should be divided by 12).

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.
Recommended reorder points are in question as the lead time in use is less than 1 day. This could only occur due to data corruption and/or data insertion since OAS does not allow users to set total lead time to 0 days. This error needs to be reported to an OAS system administrator to be corrected in the database or the configuration.

To correct this exception, follow the below steps:

1 – Select an appropriate lead time code (average, manual or planned delivery) and reset the total lead time that accurately reflects the item.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.
D03 – Price is zero

OAS cannot recommend reorder points as a unit price has not been identified.

To correct this exception, follow the below steps:

1 – Select manual unit price and enter a price greater than $0.01.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.
D04 – Disparity between average and last price

OAS cannot recommend reorder points due to a significant discrepancy between average unit price and the last receipted unit price.

To correct this exception, follow the below steps:

1 – Select manual unit price and enter the average unit price.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.

D05 – Invalid Likelihood option selected

OAS cannot recommend reorder points as the Likelihood option [located in the Results tab] has not been selected.

To correct this exception, follow the below steps:

1 – Select an appropriate Likelihood option.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.
D06 – Invalid business impact code

OAS cannot recommend reorder points as the business impact code/item criticality [located in the Header section] has not been selected.

To correct this exception, follow the below steps:

1 – Select an appropriate Business impact code

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.

D07 – Invalid availability code

OAS cannot recommend reorder points as no availability code [located in the Codes tab] has been selected.

To correct this exception, follow the below steps:
1 – Select an appropriate Availability code

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.

**D08 – Create date is invalid**

OAS cannot recommend reorder points as the item’s create date [located in Forecast tab] is not a valid date (where create date is greater than current date).

To correct this exception, follow the below steps:

1 – Arrange to have the OAS item create date (Date Created) reset to a valid date.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.

**D09 – Average issue size is less than 1**

OAS cannot recommend reorder points as the average issue size is less than 1.

To correct this exception, follow the below steps:

1 – Select Manual issue size and enter a value greater than or equal to 1.

2 – Recalculate by executing the command Tools > Recalc Current.
3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.

**D11 – Invalid reorder method**

OAS cannot recommend reorder points as a reorder method has not been selected.

To correct this exception, follow the below steps:

1 – Select an appropriate reorder method.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.

**D12 – Invalid combination of ROP/ROQ method**

OAS cannot recommend reorder points as an incorrect combination of ROP/ROQ method has been selected.

To correct this exception, follow the below steps:

1 – Reset the ROP and ROQ methods based on allowed combination as shown below.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.

**Accepted Min/Max Method Combination**

(If highlighted and marked with “X” then not accepted)
<table>
<thead>
<tr>
<th>ROP/Min</th>
<th>ROQ/Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Value</td>
<td>Current Value</td>
</tr>
<tr>
<td>Define Minimum</td>
<td>Optimal</td>
</tr>
<tr>
<td>Safety Stock Units</td>
<td>Fixed Service Level</td>
</tr>
<tr>
<td>Weeks of Safety Stock</td>
<td></td>
</tr>
</tbody>
</table>

**D13 – Max parameter must be greater than min parameter**

OAS cannot recommend reorder points as the entered ROP value is greater than the ROQ value.

To correct this exception, follow the below steps:

1. Correct the values so the ROQ/Max is greater than or equal to the ROP/Min.

2. Recalculate by executing the command Tools > Recalc Current.

3. If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.

**D14 – Max/ROQ parameter must be integer**

OAS cannot recommend reorder points as the entered ROQ value contains a non-integer value.
To correct this exception, follow the below steps:

1 – Re-enter the Max/ROQ as an integer value greater than or equal to the entered Min/ROP value.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.

**D15 – Min/ROP parameter must be integer**

OAS cannot recommend reorder points as the entered ROP value contains a non-integer value.

To correct this exception, follow the below steps:

1 – Re-enter the Min/ROP as an integer value less than or equal to the entered Max/ROQ value.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.

**D16 – Service level parameter outside limits**

OAS cannot recommend reorder points as the entered service level value is outside the acceptable range of 10% to 99.9%

To correct this exception, follow the below steps:

1 – Correct service level to a desired outcome value ranging from 10.0 to 99.9%.

2 – Recalculate by executing the command Tools > Recalc Current.

3 – If recalculated recommended reorder points are acceptable, mark it as “Ready to Export” and export the reorder points by executing the command Tools > Run Export.
6.1 Reporting with OAS

OAS is designed with tools to generate a variety of reports. Users can generate Metric Reports which can be exported into MS Excel.

**Dashboards and metrics**

KPI metrics are updated monthly by OAS and can be viewed directly from the workbench.

Select the Home icon from left window pane and navigate to the dashboards tab. Click on the 🌟 icon to display the command selection dialog box. To add a graph to the Dashboards tab, select New Dashboard.

To change the graph, click the bar or line on the graph and the colour will change to grey. Then click on the left arrow icon to expand the metric selection box.
Select an appropriate metric using the dropdown list. The Ellipse button navigates to the metric definition screen to provide details on the data being captured.

Add another graph by clicking the Copy to new graph button from the metric menu screen.
Again, to change the newly added graph to a desired graph, click the graph’s bar or line and the colour will change to grey. Then select the desired metric using the dropdown list.

When a metric is selected, the graph display and the title are changed accordingly.

The graphical display can be changed to a line graph instead of bar graph by changing the display type.
In order to reorder or combine graphs, select a graph and place the cursor to the “...” located above the graph until a cross arrow cursor appears. Then left click to hold down and drag to the destination graph where down arrow and plus signs are displayed.

By placing the cursor on the down arrow, the display order will change.

By placing the cursor on the plus sign, two graphs are now combined. This process can be repeated to combine more than 2 graphs if there are less than 2 unique y-axis definitions. The below combined graph shows two unique y-axes: the left side y-axis shows issue value and the right-side y-axis shows the receipt count.

Placing the cursor on the title and double clicking allows the user to change the graph title.
To copy data from the displayed metrics, click the setting icon and select Copy data to dashboard. This data can now be pasted into an Excel spreadsheet.

To hide the metric selection display box, click the icon.

Note that the display is a global system setting; therefore, all users will see the same Metrics.

To remove unwanted dashboards, click on the setting icon and select Delete dashboard.
6.2 Importing data in OAS

**Bulk loading of new stock items into OAS**

New item information can be imported into OAS to determine the optimal stocking levels based on known data. The levels recommended by OAS can then be used as initial stocking levels in the ERP when creating new items.

Update the New Item List Excel spreadsheet by entering new items, filling in the columns and saving the file using the following instructions.

Uploading the file to the FTP site - for OAS Cloud users

Log onto the Oniqua FTP site using the following URL address: https://aoftp.oniqua.com/login.html

Enter required log-in credentials where Account=Oniqua cloud user name and Password=network password.

Upload the completed excel spreadsheet to the FTP site by clicking on the up arrow icon.
From the Upload File prompt, click the Browse Files button to select the new item list spreadsheet from the directory where the file is located and click the Open button.

Once the file has been selected and shows on the Upload File dialog box, click the Upload button.

Once upload is completed, the file is now on the FTP site and now ready for use. Click the close button in the Upload File dialog box.

Loading the new item data in OAS

Right click on any data set and click New Group.
Mark the Group Type as New Items from File and click Add.

Select the appropriate directory from the dropdown list, select the Excel file and click OK. For users on Oniqua Cloud, go to the FTP directory where the file is located by clicking Computer and H: directory displaying your name.
Select the file (on File Details) and enter a data group name, then click CREATE.

OAS will create a data group and place it under an external data set.
Verify item criticality, unit price, estimated lead time, average issue size. Click Recalc or command Tools/Recalc All for OAS to determine replenishment settings for the new items.

Click the save icon to save the calculation results and exit.
6.3 Loading projected/planned demand usage into OAS

Planned or known future usage information can be imported into OAS to determine appropriate stocking levels based on future usage instead of past historical usage.

Update the Projected Demand Excel spreadsheet by entering items and corresponding planned usage and save the file.

If OAS is on Oniqua Cloud, you must use the FTP site to import the files – see section 6.3.1 for details on how to upload a file to the FTP.

Right click on appropriate data set, create a Returnable data group for all item records and open.

Click the “Import Projected Demand” button to initiate the import of known future planned usage associated with items in the group.
From the “Import File”, select the appropriate projected demand spreadsheet, then enter the start date of projected usage month on the “Values Start From”. Complete the remaining fields by setting “Import Records” to “All” and “Forecast Mode” to either Use Actual and Projected Usage or Use Projected Demand Only. Click on the Import button.

For users on Oniqua Cloud, go to the FTP directory where the file is located by clicking Computer and H: <directory displaying your name>.
Click the “OK” button as dialog boxes are prompted during the import process.

Imported data are now visible both in table format and graphical format (as indicated by light blue colored bars)
Recalculate the recommended replenishment levels using the imported projected usage.

If the items are to use imported projected usage to determine the stocking levels, then export the recommended stocking levels and save and return the group.